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 JMAG Newsletter: Highlights of the March Issue 
 

This is the final issue of the JMAG Newsletter for this fiscal year. 

 

For this month’s Implementing JMAG, we interviewed Mr. Charles R. Frontczak from Tempel Steel, the world’s leading 

manufacturer in the field of magnetic steel sheet. He spoke openly on how JMAG can be used to select magnetic steel 

sheet while striving for cost performance, and what functions are useful for dealing with extensive design proposal trials at 

the initial design stage. We are happy to present these to you along with content from his presentation at the JMAG Users 

Conference 2012. 

 

The Technical FAQ focuses on the many questions we receive. At the moment, we are requesting that JMAG-Studio 

users move over to JMAG-Designer. We reply to some of their concerns, such as whether the files they have been using 

until now can be used in JMAG-Designer. 

Also, we have redesigned our Technical FAQ webpage as of March. It is now possible to search by function or by motor, 

transformer, or other application, so searching has become even easier. Please feel free to use this along with JMAG 

technical support. 

 

There are an almost infinite number of technical documents and papers in the world. In our Paper Introduction, we are 

pleased to present papers that engineers at our company have found useful. This month, we introduce materials 

necessary for analysis, focusing on people who are planning to begin using analysis for large transformers. It can be very 

difficult to take on a whole new field. This issue introduces materials that have been useful for our engineers in solving 

problems and gaining basic knowledge. 

 

Finally, we would like to inform you that JMAG-Designer Ver.12.1 is planned for release in May, 2013. Ver.12.1 will 

include general-purpose interface mapping functions, which will greatly improve its ability to link with other software. 

Constraint functions will also be improved. In addition to these, it will be faster and easier to use, thanks to functions for 

easy creation of 3D models, functions to improve reusability of CAD models, mesh robustness functions, functions for 

considering distortion due to processing, and others. Further details will be provided in the next issue, so please look 

forward to that. 

 

The JMAG Newsletter is intended for everybody, from those who are currently using the product, to those who have not 

started yet, to those who have just started using it. 

By all means, take this chance to introduce it to someone nearby. 

 

This edition of the JMAG Newsletter is packed with more content than ever. We hope you enjoy it. 

 

 

JSOL Corporation 

Electromagnetic Engineering Department, Engineering Technology Division 

JMAG News letter (March,2013）3



 
 

 

Implementing JMAG 

Tempel Steel, 
Evaluation and Selection of Electrical Steels 
using Simulation 

 
The world's leading manufacturer in the field of electrical steels, Tempel Steel. Tempel Steel has continued to provide 

electrical steels used in a variety of electrical devices such as motors for all applications including vehicles, generators, and 

transformers. JSOL’s electromagnetic field analysis software “JMAG” is used in their development. 

We interviewed Mr. Charles R. Frontczak and heard how JMAG is used to select appropriate electrical steels on a 

cost-benefit basis. This report also includes content from the presentation he gave at the JMAG Users Conference 2012. 

 

 

— Can you give us some details about Tempel 

Steel and its business activity? 

C.R.Frontczak:  Tempel steel is a 65 year old 

company and is still privately held. It deals primarily 

with precision electrical steel stamping for 

motor/generator and transformer industry. We also 

perform laser-cutting, deburring, recoating as well 

as die-casting and welding operations. We utilize 

the engineering know how experience along with 

precision tooling and presses that range from 10 to 

550 Tons. Progressive as well as blank-and-notch 

dies are designed, built and maintained by Tempel 

Steel. We are also a trusted name when it comes to 

electrical steel performance data. Headquartered in 

Chicago, Illinois we have a global footprint with 

operations in Canada, Mexico, China and India.  

 

 

 

 

 

— What kind of work are you doing? 

C.R.Frontczak:  I work within the Marketing 

Technical Services (MTS) group as the 

electro-magnetic (EM) design engineer for 

electro-magnetic devices (i.e. motors, generators, 

 

transformers, ignition coils, etc.). More specifically, I 

show our customers how their designs perform 

through simulation with different types of electrical 

steel grades using the JMAG software. Cost 

reductions and improved efficiencies usually drive 

our customer’s requests. 

 

— What initially triggered you to use JMAG? 

C.R.Frontczak:  The initial trigger was to fill a 

need that was recognized by Tempel Steel, which 

was to have an EM engineer helping their 

customers make an economical decision in 

choosing their designs and materials. We needed 

an FEA tool to accurately capture the losses and 

predict the performance quickly and efficiently.  

JMAG fits our need with being flexible and accurate 

with a quick turn-around time. 

 

— How is it useful for your business and study? 

C.R.Frontczak:  I value JMAG from its easy 

interface, to the parametric case studies that I 

 

 

 

 

 

Tempel Steel 

Sr.Electric Motor Design Engineer, 

Charles R. Frontczak 

JMAG News letter (March,2013）4



 
 

 

create in solving customer scenarios. For example, 

I set-up different lamination stack lengths and 

adjust the other parameters such as steel materials, 

copper and or aluminum turns and resistance to 

determine flux densities and iron losses. This 

enables me to improve efficiencies and reduce 

materials to cut costs. 

 

Flux Density of IPM motor 

 

— What would you estimate as the time difference 

between setting up and getting results in JMAG 

compared to other tools or non FEA tools? 

C.R.Frontczak: I can setup a JMAG model within 

3-4 hours and usually have a rough answer that 

same day. Then by tweaking the mesh tighter and 

setting-up the parametric case studies… I can send 

the model to a batch queue, let it run over night and 

have my answers the next morning. Without JMAG, 

I would be required to set-up the magnetic circuit on 

paper or use a homemade spreadsheet program to 

calculate the flux densities. Then I would calculate 

the performance characteristics based on the flux 

values and determine the power loss and thereby 

efficiency. However, JMAG provides a wealth of 

data that I can dig into to analyze the model. 

Additionally, Tempel Steel has the ability to fully test 

all electrical steel properties with a wide range of 

inductions and frequencies. This data allows me to 

input accurate steel curves which enables the FEA 

analysis to become more powerful.  

— Anything you would like JMAG to improve? 

C.R.Frontczak: Yes. I still do some things as “Old 

School”. Example is when I assign FEM coils in my 

model; I link one coil group at a time to my circuit of 

individual FEM coils. This way the coils are not 

bunched together, and I can change their values 

during multiple studies. In doing this however, I 

would like a numbering and color coding sequence 

to take place as to avoid assigning FEM coils to 

duplicate geometry. I indicated this idea to the 

people at JMAG and they were very interested in 

making this change. In fact, my experience has 

been that they are very willing to adapt their 

software to customer input. 

 

— What is your outlook for the future regarding 

electrical steel and its market? 

C.R.Frontczak: Our customers are always looking 

to improve efficiency and reduce costs. Therefore, 

they look to us to help them in their efforts. 

Electrical steel pricing will remain volatile, so it’s 

imperative to have an FEA tool such as JMAG to 

look at performance behaviors as steel materials 

may change due to pricing pressures. 

 

— Finally, do you have any opinions/comments you 

would like to share with JMAG/JSOL? 

C.R.Frontczak:  Well, I do appreciate the 

on-going technical support, and the organization is 

always interested in improving their software. In fact, 

since I purchased JMAG 2 years ago I’ve seen 

updates every 6 months. I’m glad I did my initial 

research on Finite Element software and chose 

JMAG. It has made my job easier and fun to be able 

to work on so many different designs and to have 

detailed results and images to share with our 

customers.  

Thank you very much, Mr. Charles R. Frontczak 
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Interviewer: Dheeraj Bobba, Powersys Solutions 

 

Presentations of JMAG Users Conference 

2012 

 

Evaluation of Different Electrical Steels and 

Iron Loss evaluation of inter-locks vs welds vs 

bonded lamination cores in IPM Hybrid Motor 

using JMAG 

This presentation focuses on electrical steel grade 

selection for Hybrid I.P.M. Electric Motors. 

Choosing the proper steel is the foundation of any 

good electro-magnetic machine. In most cases, 

there is insufficient data available for accurate 

properties of steel characteristics, especially high 

frequencies. Tempel Steel has developed methods, 

including Epstein and ring tests that generate a 

comprehensive range of core loss, permeability and 

magnetizing force data as functions of both 

frequency and induction. The use of this data input 

in JMAG allows the user to make educated 

decisions and places numerical values for each 

case study.  

Additionally, it has added the iron loss differences 

between three methods of securing lamination 

stacks. These three methods are inter-locking, 

welding, and bonding. This analysis was 

accomplished with the JMAG 2D software, future 

effort will incorporate JMAG 3D simulation analysis, 

and lab test results. 

 

Iron loss density of the interlocked model 

 

Cited verse JMAG Users Conference 2012 

Presentations, Tempel Steel Company Mr. Charles R. 

Frontczak, “Evaluation of Different Electrical Steels 

and Iron Loss evaluation of inter-locks vs welds vs 

bonded lamination cores in IPM Hybrid Motor using 

JMAG” 

 

 

 

 

 

 

 

Tempel Steel 

5500 North Wolcott Avenue Chicago, IL. 60640 

Tel: +773-250-8000 

http://www.tempel.com/ 
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Explaining FEA: Effectiveness of FEA in the Development Process  

Is FEA Effective in Motor Design? 
Issue 2 Making Use of FEA in Detailed Design 

 
This issue is aimed at those designing or using motors, to let you know the effectiveness of utilizing simulation. We 

hope you will find this useful as a reference for designing better motors.  

 

 

Overview 

As computer hardware and software becomes more 

advanced, finite element method electromagnetic field 

analysis (hereafter FEA) is being used more, and its real 

effectiveness in development facilities is growing. 

However, if you talk to people who are not using FEA 

now, there are many who say things like “I’ve heard that 

FEA is good, but we can accomplish the same things 

with our current development process, so we don’t need 

it,” or “It seems like it would take a lot of time and effort to 

adopt it.” 

This series attempts to respond to the concern of "why 

is FEA effective in motor design?" We hope this helps 

you to understand the benefits of using FEA for better 

motor design. 

In Issue 1, I discussed the use of FEA at the concept 

design and initial design stages in motor design. Here in 

Issue 2, I will present uses for FEA at the detailed design 

stage. The goal at this stage is to optimize design 

variables based on rough proposals determined at the 

concept and initial design stages, and then to settle on 

design parameters such as measurements, conditions, 

and material properties for the various parts. We will 

discuss effective use of FEM in design optimization at 

the detailed design stage, and how to analyze FEA 

results and apply them to designs. 

 

Improved Performance and Development 

Issues in PM Motors 

The following is an outline of the difficulties in 

improving performance in detailed design, not limited to 

motors. 

1: Balancing trade-offs to find optimal values 

There is a wide range of issues to solve in order to 

improve motor performance. Many of these have 

trade-off relationships with others, such as reducing iron 

loss to improve efficiency and reducing torque variation 

so it will not cause vibration, so when one is prioritized, 

others are hindered, and finding the proper balance is 

never easy (Fig. 1). For example, magnet volume can be 

increased to improve output density, but this makes cost 

reduction more difficult. In order to choose the best 

values among these complicated trade-off relationships, 

designers must have quantitative knowledge of the 

relationships between solutions to the various problems, 

and FEA that encompasses the physical phenomena is 

vital for this. 

 

 

Fig. 1 Improved performance and development issues in motors 
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2: Pushing it to the limit 

Motors are already quite efficient compared to other 

energy-conversion devices. Improving this efficiency 

even further is the goal, so efforts must be made to poke 

into every little corner in order to reduce loss. FEA is 

unrivalled for the sort of minute test studies needed for 

this purpose. 

3: The need to draw out new abilities 

If all issues could be solved by extension of the design 

techniques used in the past, then veteran designers 

would be able to produce design proposals using 

magnetic circuit methods, etc., based on their 

experience without using FEA. However, it becomes 

necessary to jump up to a new level over past 

experience in order to push optimization of trade-offs all 

the way to the limit. In cases like these, it is extremely 

hard to accomplish only by extrapolating past experience, 

but with FEA, even unconventional ideas that would give 

pause for prototyping can be tried out. 

 

Creating Performance in Detailed Design 

Models can be made precisely and even nonlinear 

magnetization properties for materials can be accurately 

modeled in FEA, so the complex electromagnetic 

phenomena occurring inside a motor can be reproduced. 

Designers’ ideas can be brought to life and evaluated 

right on the desktop, allowing better design proposals to 

be advanced. Below is an explanation of the benefits of 

FEA, including concrete examples. 

 

Reduction of Cogging Torque 

For example, there are times when you may want to 

reduce cogging torque in a high-end motor. Cogging 

torque is highly sensitive to details of a motor’s geometry 

and is also affected by material properties, so it poses a 

difficult design theme. 

It is well-known that one solution to reduce cogging 

torque is to add skew to the rotor or stator, but because 

this has demerits such as a fall in productivity, reduction 

in torque coefficient, forces generated in the slant 

direction, etc., designers are instead expected to reduce 

cogging torque by optimizing magnetic circuit geometry 

rather than adding skew. Although it is easy to talk about 

optimizing magnetic circuits, the parameters are in fact 

quite complex. A main cause of cogging torque is 

intermittent changes in magnetic resistance in the stator 

due to the coil slots, so it can be reduced by 

appropriately designing the pole arc angle of the 

magnets and the slot pitch. Figures 2 and 3 show a study 

of variations in pole arc angle with the design parameter 

of magnet width in an SPM motor. In this study, with 

magnet width varied from 14 mm to 11 mm, minimization 

occurs at 12.5 mm, being about half compared to the 

initial value of 14 mm. However, if magnet width is made 

any thinner than this, cogging torque starts to increase, 

and is much higher at 11 mm even than at the initial 

value. 

 

Fig. 2 SPM motor geometry 
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Fig. 3 Differences in cogging torque due to magnet width 
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In an actual motor, the magnets’ corners are given an 

angle R in order to prevent magnet breakdown and 

peeling of the magnets’ surface treatment. For the 

magnetic circuit, this makes switching at the boundary 

more lenient, so it can be expected to have an effect on 

cogging torque reduction as well. A study is conducted 

on this model with magnet angle R varied from 0.25R to 

1.5R, with 1.0R showing minimized values (Figures 4 

and 5). 

 

Fig. 4 Differences in magnet angle R geometry 
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Fig. 5 Differences in cogging torque due to magnet angle R 

 

FEM shows its true power in studies such as this kind 

of reduction of cogging torque. Only cogging torque 

reduction has been focused on here, but it can also help 

to determine geometry by evaluating the motor’s induced 

voltage waveform and torque coefficient in parallel. 

Cogging torque analysis is a comparatively 

advanced-level use of FEA, so it is necessary to take 

adequate care of the modeling process, such as the 

symmetry of the mesh. 

Optimized Design of the Rotor’s Magnetic 

Circuit 

Optimal use of material properties and efficiency in 

magnetic circuit design are called for to meet demands 

for smaller and lighter motors. If designs are made to 

allow some leeway in terms of magnetic saturation in the 

materials, it is possible to avoid a reduction in 

controllability due to increased iron loss and nonlinearity, 

but this leads to an increase in motor size. On the other 

hand, not providing this leeway means a reduction in the 

torque coefficient, higher loss, and worse controllability 

due to materials strain. For this reason, it is necessary to 

properly grasp the degree of magnetic saturation in 

order to design magnetic circuits that are not wasteful 

and not overloaded. This can be evaluated to a certain 

degree using the magnetic circuit method, but FEA is 

indispensable for designing to the limit. In particular, the 

magnetic circuit around the magnets in an IPM motor’s 

rotor is extremely delicate, and has a large effect on the 

torque coefficient, iron loss, and torque variation. 

Professor Yamazaki of Chiba Institute of Technology 

presented his results from optimized design of an IPM 

motor in his keynote address at the 2012 JMAG Users 

Conference (although unfortunately the study results 

used FEA developed by Professor Yamazaki himself). 

An improvement in performance was achieved by 

creating an appropriate slit near the rotor’s air gap, but 

because in practice this type of measure means an 

increase in the length of the air gap and thus an increase 

in magnetic resistance, common sense seems to tell us 

that this should not contribute to an increase in motor 

performance. In fact, however, because the flow of the 

magnetic flux in the rotor became more ordered, iron 

loss was reduced thanks to suppression of higher-order 

components, and it was shown that the overall 

performance and efficiency of the motor was improved. 

In the future, it seems likely that this type of thinking 

about proper control of the magnetic flux flowing in the 

magnetic circuit will become more widespread. This sort 
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of idea is made possible thanks to the use of FEA. 

 

Yamazaki Katsumi, Chiba Institute of Technology, “Loss 

analysis and shape optimization of rotating machines,” 

presentation materials from JMAG Users Conference 2012. 

The above material can be accessed via the JMAG 

users-only webpage: 

http://www.jmag-international.com/support/en/documentatio

n/seminar_uw2012.html 

 

Appropriate Magnet Geometry Design 

It goes without saying these days that the rare earth 

magnets used in rare earth magnet motors are 

expensive. For this reason, designers want to get the 

maximum performance while using the minimum amount 

of them. Furthermore, these magnets are very delicate 

materials that are particularly susceptible to reduced 

magnetic properties due to raised temperatures, so 

adequate care must be taken of their useful temperature 

range so that they do not undergo thermal 

demagnetization. Also, field weakening controls are 

used to widen motors’ output range, but since these 

weaken their field, there is great danger of 

demagnetization. Because it is difficult to restore a 

magnet’s properties once it has undergone irreversible 

demagnetization, it is necessary to anticipate the 

surrounding temperature and tolerance for overloading 

in order to prevent demagnetization. 

The following is an example of how motor 

characteristics change with variations in magnet width in 

an IPM motor. With the magnet thickness increased from 

2.5 mm to 4 mm, attention is given to no-load induced 

voltage, torque, and the average magnetic flux density of 

the magnets (Fig. 6). An increase in thickness from 2.5 

mm to 4 mm means a 60% increase in magnet volume, 

but induced voltage only sees an 8.3% increase. 

However, torque is increased 15.4%, with confirmation of 

this torque increase due to an armature reaction 

resisting the reverse magnetic field when the magnet is 

made thicker. Further, the average magnetic flux density 

for the whole magnet increases 23.8%, from 0.52 T to 

0.65 T (Fig. 7). These results tell us that the risk of 

demagnetization from heat and reverse magnetic field is 

reduced because the magnets’ operating permeance is 

higher. This is to say, torque may not be much reduced 

with a reduction in magnet volume, but the risk of 

demagnetization becomes much higher. 

 

Fig. 6 Motor model used for magnet thickness study 
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Fig. 7 Effects of properties due to magnet thickness 

 

Neodymium sintered magnets are notorious for having 

relatively high electric conductivity, leading to eddy 

currents produced by slot harmonics and carrier 

harmonics that can cause heat generation, and therefore 

a rise in magnet temperature. As a workaround, divisions 

are often made in the magnets with insulating material in 

between, similar to the concept behind laminated cores. 

However, as the number of divisions increases, 
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production costs rise and magnetic properties fall, so it is 

important to design with the right number of divisions. 

The rotor and stator geometries strongly affect harmonic 

components, so a lot of factors have to be taken into 

account in order to determine the number of divisions. 

The number of magnet divisions and reductions in eddy 

currents are shown below (Figures 8 and 9). 

 

Fig. 8 Motor model used for magnet eddy current loss study 

 

 

Fig. 9 Reduction in eddy current loss due to magnet division 

 

Maintaining Revolution Strength 

 Higher revolutions are essential for higher motor output. 

In terms of mechanical strength, rare earth sintered 

magnets are hard and brittle, so there is a danger of 

rupture if centrifugal force acts on them locally due to 

high-speed revolution. When the SPM motor in Figures 

10 and 11 rotates at 10,000 rpm, the stress 

concentration generated in the magnet by centrifugal 

force is as shown. This model’s structure has the core 

holding the corners of the magnet, and around 500 MPa 

of stress is produced in places. Since the compressive 

stress of rare earth magnets is supposed to be 1000 

MPa, it can be seen that it has a safety factor of only 2. 

 
Fig. 10 Rotor model geometry for the SPM motor 

 

 
Fig. 11 Stress concentration generated in magnet during rotation 

 

In IPM motors, where the magnets are embedded 

inside the rotor, the bridge part of the core supports the 

magnets’ centrifugal force, and so concentrates the load 

in itself. From the standpoint of the magnetic circuit, it is 

better to design the bridge thinner to suppress leakage 

flux in the rotor, but if it is made too thin, it becomes 

unable to withstand the centrifugal force. Therefore, it is 

necessary to achieve a geometry that satisfies the needs 

of both the magnetic circuit and mechanical strength. To 

investigate these, the magnetic circuit is evaluated with 

magnetic field analysis, and the rotational mechanical 

strength is evaluated using structural analysis. The 

stress distributions produced in an IPM motor’s bridge 

are shown in Figures 12 and 13. 

 

No division   2 divisions    4 divisions    8 divisions 
(Unit: W/m3) 
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Fig. 12 Rotor model geometry for the IPM motor 

 

 

Fig. 13 Stress concentration generated  

in bridge area during rotation 

 

Adjusting Output Characteristics 

 The proportion of iron loss within total loss increases 

with higher rotation in motors, and high-output motors 

can have equal amounts of copper loss and iron loss. 

How to control iron loss is a major issue in motor design 

when it comes to improving efficiency. Iron loss can be 

reduced by lowering the operational magnetic flux 

density using magnetic pathways with some leeway or 

by using materials with lower iron loss, but these lead to 

larger motor size and higher cost, and so cannot be 

adopted easily. 

 Because of this, what designers apply themselves to is 

seeking versatile designs that maintain the necessary 

maximum torque while keeping a high-level balance 

between cost, size, and output. They do this by focusing 

on high efficiency over the entire range, realizing high 

efficiency in output range over longer operating times 

while ignoring efficiency in output range for shorter 

operating times. 

The example in Fig. 14 uses efficiency maps to show 

the difference in output characteristics when magnets in 

the same stamped motor geometry are replaced with a 

Br1.0 T material from a Br1.2 T material, and the 

difference is made up for by changing the number of 

turns in the coils to maintain the same torque coefficient. 

There is no difference in maximum torque before and 

after the replacement because the torque coefficient is 

the same, but because of increased iron loss, the torque 

at 3000 rpm is reduced from 2.6 N·m to 2.1 N·m, 

meaning a large decrease in output. Similarly, the torque 

at 6000 rpm goes down from 1.5 N·m to 1.0 N·m. Still, 

this could be recommended in situations where a 

reduction in magnetic properties to lower costs is 

prioritized, because overall efficiency is realized at more 

than 90% over a wide range in both cases. 

 

 

 

Fig. 14 Differences in output characteristics and efficiency 

(Above: efficiency map of magnet Br1.2(T); Below: efficiency map 

of magnet Br1.0(T)) 
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Reducing Torque Variation 

Torque variation, a cause of vibration and noise in 

motors, needs to be reduced in order to improve 

performance and quality. Torque variation is influenced 

not only by the motor’s structure, but also by the phase 

current waveform, so analysis using FEA is essential. 

Adding high harmonic components to the flowing 

current changes the torque waveform. Figures 15 and 16 

show results from analysis of torque variation when the 

drive is by a sinusoidal-wave current and when 

third-order current has been added. It can be seen that 

there is a difference in the torque waveform when a 

third-order component of 0.5 A is superimposed and 

when 1.0 A is superimposed onto the fundamental 5 A 

wave. In this study, the torque variation was not reduced 

to zero, but it is possible to suppress a current waveform 

to zero by adjusting the amplitude and phase of each 

superimposed order. 

 

Fig. 15 Phase current waveform with superimposed 3rd order 

harmonic 
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Fig. 16 Changes in torque variation due to flowing current 

In Closing 

Issue 2 of “Is FEA Effective in Motor Design?” has 

presented example uses for FEA during detailed design. 

The examples here have focused on evaluation issues 

for permanent magnet motors, but these apply similarly 

to inductance motors and SR motors. 

I hope you have come to understand just how valuable 

using FEA can be for detailed motor design. It is nearly 

impossible to carry out this kind of study using only 

calculation by hand and experience. 

Of course, I do not mean to say that just using FEA 

guarantees good design. Engineers who have never 

designed a motor, however well versed they are in how 

to operate FEA, will not be able to apply the results to 

their designs. What I hope you will take away from this is 

that engineers who are already familiar with motor 

design will be able to put FEA to use in creating even 

better designs. 

In the next issue in this series, I plan to explain how 

even more detailed motor design can be accomplished 

using FEA. In particular, I will present how to take 

advantage of its potential to find the cause when 

problems arise in a real motor. 

(Yoshiyuki Sakashita) 
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Paper Introduction 

Issue 3 For Those Planning to Start 
Analysis of Large Transformers 

 

In this series, I would like to introduce various papers that present ways of using JMAG while performing 

electromagnetic field simulation. In Issue 3, I will introduce ten pieces (refer to [1] through [10] in Reference) of 

literature that will serve as a good reference for users who plan to start using electromagnetic field simulation for large 

transformers. 

 

 

Introduction 

I will be introducing some papers for you in this 

issue. I have been working on analysis technology 

for large transformers since last year. Here, I will 

present materials that will serve as a reference for 

people who, like me, are just getting started with 

analysis of large transformers, focusing on 

electromagnetic field analysis using the finite 

element method (FEM). Of course, the materials 

chosen here represent my perspective only, and I 

hope you will be understanding toward any 

seeming biases that I may have been unable to 

avoid. 

 

What Should I Read First? 

Large transformers, like other electric machines, 

have been around for more than a generation, and 

a wide variety of papers and other materials have 

accordingly been produced. The general trends can 

be found by looking at these, but there is such a 

large number that it is very difficult to know which to 

read first. I personally am interested in history, so I 

have chosen to take a long view of large 

transformers within the history of technology. 

Technological history is not a good way of learning 

about technical issues in detail, but I think it is a 

good approach for getting a broad overview of large 

transformers in general. 

Here, I would draw your attention to Reference 

[1]. The author has been involved in the 

development of large transformers at a large 

manufacturer for many years, and he discusses 

technological changes in large transformers over 

time from the standpoints of reliability, higher 

capacity, higher voltage, environmental issues, and 

accessory parts. He includes his own experiences 

such as an insulation breakdown incident when 

conducting the first 500kV test transmission in this 

country, and I think he makes it easy to read even 

for people who are not familiar with the field. It 

should be useful for gaining and systematizing 

basic knowledge. 

I think this is an interesting way of seeing how the 

history of technology has led to today’s technology, 

almost like watching a documentary film with its 

glimpses of human drama as opposed to a textbook 

full of specialist terminology and technical 

descriptions that may sometimes leave you staring 

blank-faced. 

 

Materials on Large Transformer 

Analysis Using FEA 

The purpose of a transformer is to provide a 

transformation ratio for its application, and large 
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transformers are those that handle tens of kV on 

their high-voltage side, tens of kA on their 

low-voltage side, and electrical power in the 

hundreds of MVA. Because of this, electromagnetic 

phenomena such as leakage flux, loss, 

magnetostriction and electrostriction vibration, and 

others, all caused by the high electric field and large 

current at this scale lead to technical problems. 

I will introduce some materials dealing with these 

problems in sections for: loss analysis; electric field 

analysis; magnetostriction and electrostriction 

vibration analysis; and transient phenomena and 

electromagnetic force analysis. 

 

1. Loss Analysis 

One of the most promising uses for 

electromagnetic field FEM is the analysis of stray 

loss caused by leakage flux in large transformers 

(Fig. 1). 

The large current produced on the low-voltage 

side generates leakage flux and stray loss inside 

the tank. The stray loss does not only have one 

fixed value, but can cause localized heat generation 

in the tank. Understanding and suppressing this 

stray loss is a design issue. 

For stray loss analysis, it is necessary to include 

not only the core and coils, but also surrounding 

structural parts such as the tank and clamps, so the 

analysis model inevitably grows in scale. The issue 

becomes, at this point, what scale of analysis is 

possible? 

In Reference [2], a 3-phase transformer is 

represented in a full model with around 11.5 million 

elements including the tank, shield, and clamps, 

and analyzed using a region partitioning method on 

the frequency region. Also, a thermal conduction 

analysis of heat caused by loss in the tank is carried 

out and compared with measured temperatures at 

the tank surface. 

Stray loss analysis of a full transformer model 

focusing on local heat production can also be seen 

in Reference [3]. By running an FEA analysis on a 

nominal 240 MVA 3-phase transformer and 

comparing the loss density in various parts – tank, 

upper and lower clamps, cover plate (side plate) – it 

is found that stray loss is largest in the cover plate 

near the core. 

As solving speed increases thanks to the spread 

of 64-bit machines and parallel processing 

technology, it is now becoming possible to run 

analysis at around the 10-million-element level at 

our own companies or our customers’ companies. 

In the future, it is likely that even larger-scale 

electromagnetic field FEM will become possible. 

Local heat generation is not only caused by stray 

loss in parts around the core, but also by iron loss in 

the core itself. Step lap construction, which has 

been increasingly employed since the 1980s, 

contributes to a reduction in iron loss, but at the 

same time it has led to problems with local heat 

generation at joints. It is unfeasible to directly 

reproduce the core in step lap construction because 

the analysis model becomes too large, but, 

because it is localized heat generation, an 

argument can be made for partial models focusing 

on joints. 

In Reference [4], attention is given to step lap 

construction and overlap construction, and the local 

loss distribution in each is compared. A 

homogenization method of equivalent values is 

proposed from magnetic properties measurement, 

this is applied to transformer models, and iron loss 

values for each construction are compared. 
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Fig. 1 Stray loss analysis of the tank and its interior 

 

2. Electric Field Analysis 

Adequate insulation measures are necessary on 

the high-voltage side because accidents in 

transformers are often caused by local insulation 

breakdown phenomena. It seems that evaluation 

using partial models focusing on transformer legs is 

common for evaluating insulation using electric field 

analysis, due to how localized and detailed the 

phenomena are (Fig. 2). 

In Reference [5], attention is given to one leg of a 

3-phase transformer, and the electric potential and 

electric field distribution are compared using steady 

state analysis by creating separate models for: the 

leg and coil adjacent to the tank wall; and the leg 

and coil adjacent to the next phase. Where electric 

field is expected to be high – the area around the 

pressboard and the start of the coil winding – 

modeling is done at the single-strand level (and 

changed to a bulk coil model partway through), and 

then differences in the electric field distribution in 

each region are compared. No clear difference is 

found between the two in this paper, but it is 

interesting to see what points designers pay 

attention to when using simulation to install 

insulation measures. 

Reference [6] points out the importance of 

instantaneous electric field generation under drive 

and material nonlinear properties. An electric field 

analysis of the area near the pressboard, using the 

pulse waveform, is carried out by solving continuity 

and Poisson equations in the time domain. 

Nonlinear properties of physical values are 

accurately handled in analyses of the time domain. 

The conductivity’s dependence on the electric field 

is compared from the electric load distribution and 

electric field distribution in the analysis results. It is 

found that materials with nonlinear properties have 

a higher instantaneous electric field peak value than 

linear materials. 

 

Fig. 2 Electric field analysis of pressboard 

 

3. Magnetostriction and Vibration 

Analysis 

Power generation facilities and substations 

generally have to be established a certain distance 

away from living environments, but with new 

residential areas being developed, borders 

between the two are frequently coming closer. 

There has been a lot of talk about the effects on the 

human body of the magnetic field generated by 

transmission lines, etc., but at this time no causal 

relationship has been established. Rather, there 

has been a greater demand for reduction of the 

more directly felt problem of low-frequency noise 

produced by substations, and more work has been 

done on vibration reduction and sound dampening 

in the transformers inside them. 

Vibration phenomena produced in transformers 

are thought to be mainly due to magnetostriction 

and electromagnetic force, but quantitative 

evaluation using measurement by analysis has not 

been carried out much yet. In particular, because 
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the force caused by magnetostriction is not actually 

measured but rather estimated as an equivalent 

value from the amount of deformation, there is said 

to be room for disagreement about the applicability 

of that estimation. At present it is only at the stage 

of research including modeling, but it is now 

possible to find papers in which attempts are made 

to apply this to magnetostriction phenomena in 

transformers (Fig. 3). 

In Reference [7], magnetostriction-magnetic flux 

density measurement results for the L and C 

directions of directional magnetic steel sheet are 

applied in a magnetic field analysis of a transformer 

core, and the amount of deformation and nodal 

force are calculated from the magnetic flux density 

distribution. 

Reference [8] turns to the hysteresis properties 

(multivalent properties) of core magnetization 

properties and emphasizes differences by 

comparing them with the univalent properties of the 

past. 

 
Fig. 3 Magnetic flux density and Mises stress in high 

harmonic components 

 

4. Transient Phenomena and 

Electromagnetic Force Analysis 

Excessive forces can be generated in the coils of 

large transformers from Lorentz force, and 

instantaneous geometry changes from this force 

are so large that they can be seen with the naked 

eye. Especially for transient phenomena, distortion 

harmonics other than the drive frequency can be 

generated due to nonlinearity in material properties. 

For this reason, it is expected that cases dealing 

with transient phenomena will be more common in 

future studies using analysis (Fig. 4). 

In Reference [9], a formalization of magnetic field 

analysis in the time domain is applied to an analysis 

with an assumed short circuit in a transformer, and 

the Lorentz force distribution generated in the coils 

on the high-voltage side and the low-voltage side 

are evaluated along the direction of the leg. Further, 

the leakage flux from the shield and magnetic 

bypass plate and the reduction in stray loss due to 

this are confirmed. 

Reference [10] handles transient phenomena 

using a formalization of magnetic field analysis in 

the time domain and tries verifying it with Team 

Problem 21C and applying it to a 380 MVA 

single-phase transformer test machine. 

 
Fig. 4 Coil Lorentz force distribution analysis 

 

In Closing 

This article has introduced some materials that 

you may find useful in starting to use JMAG for 

analysis of large transformers. By also looking at 

the materials referenced by the papers introduced 

here, you can gain even more knowledge about 

large transformer analysis. I truly hope that the 

resources presented here will prove helpful for 

anyone planning to start electromagnetic field 

analysis of large transformers. 

(Takayuki Nishio） 
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Fully Mastering JMAG 

From the FAQ Files 
 
Traditionally, JMAG has been used mainly by technicians specializing in electrical systems, but in recent years 

there have been more opportunities for mechanical designers and others to use it for electromagnetic designs outside 
of their own field. There are probably quite a few among those who have made the transition to this unfamiliar tool 
who worry about how they should use it to perform better analyses. 

This section of the Newsletter deals with questions that we receive most often in order to help people who are 
having similar kinds of problems, and make JMAG a more user-friendly tool. 

The questions here cover a wide range of topics, such as “Operation Methods”, “Analysis Techniques”, and 
“Troubleshooting”. Please take a look at the topics that interest you. 

 

 

  OPERATION METHODS FAQ-887  

Q1．Can I use my analysis files from JMAG-Studio in JMAG-Designer? 

A1．Yes, you can use them in the JCF file format. 

The file formats that were supported in JMAG-Studio listed below cannot be used directly in JMAG-Designer, but they 

can be used in JMAG-Designer after converting them to the JCF file format. 

・ Project files (*.jsp) saved in JMAG-Studio file format. 

・ Save data file (*.ssv) 

・ Solver data file (no extension) 

A JCF file can be imported by drag-and-dropping it on the JMAG-Designer screen. 

 

Circuit files (*.cct) and point sequence files (*.pa) can be used by importing them. 

Procedures to import the files are described below. 

 

【Circuit file (*.cct) 】 

1) Open the Circuit Editor window. 

2) Select [Import Circuit] from the [File] menu. 

3) Select [JMAG CCT Files (*.cct)] under [File type] and open any circuit file (*.cct). 

 

【Point sequence file (*.pa)】 

1) Select the setting items to be used for the point sequence file and open the Edit Point Sequence dialog box. 

2) Right-click anywhere on the Edit Point Sequence dialog box and select [Import] from the shortcut menu. 

3) Select [Table file (*.pa)] in the [File type] and open any table file (*.pa). 
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【Other resources】 

Please see the following Help items for more information regarding the file formats that can be used in JMAG-Designer. 

JMAG-Designer Help > Basic Operations > Tool Bar Buttons > File 

 

  OPERATION METHODS FAQ-838  

Q２．Does JMAG-Designer include a function similar to the [Region Relation] 
function in JMAG-Studio? 

I want to create a mesh model with symmetry in order to accurately obtain the cogging torque in a motor. In 

JMAG-Studio, the [Region Relation] function was available to create a mesh with symmetry or periodicity. How can I do 

this in JMAG-Designer? 

 

A２．Yes, JMAG-Designer has an equivalent function. 

In JMAG-Designer, the equivalent function is called [Part Relation]. 

Define the relationships between parts by following the steps below before creating a mesh. 

 

1) Right-click [Mesh] under [Study] in [Project Manager] to generate the mesh. The shortcut menu is displayed. 

2) Select [Part Relation]. 

3) Click on the [Parent Part] box, and then select a part in the graphics window to use as a parent part. 

4) Click on the [Copied Parts] or [Mirror Copied Parts] box, and then select a part to use as a child part in the graphics 

window. 

5) If parts with a parent / child relationship set have rotational periodicity, select [Rotation] under [Copy Type]. 

6) Click [OK]. 

 

The relationship between parts set in the abovementioned procedure is accounted for when creating a mesh. 

 

Also, the [Rotation Periodic Mesh] function is useful when creating a mesh model with symmetry for a rotating machine 

model. 

This function makes it possible to create a mesh with symmetry in the vicinity of the gap for a model that has rotational 

periodicity. 

 

In JMAG-Designer not only the mesh generation function is still available, but also many functions to generate a more 

flexible mesh have been newly added. 

These functions are very useful, so be sure to give them a try. 

 

【Newly added mesh generation functions in JMAG-Designer】 

・ Element size specifications for edges and vertices: adjust mesh density to the specified element size. 
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・ Layered mesh: generate a layered mesh parallel to the specified solid face. 

・ Thin shell mesh: generate a mesh using a shell. 

・ Defeaturing: generate a mesh after removing fillets or chamfers. 

・ Morphing: directly change the geometry of the mesh model. 

・ Honeycomb mesh: fill in a mesh in the air region while maintaining the existing mesh. 

・ Mesh redivision: redivide the mesh in a localized region of the mesh model. 

 

【Other resources】 

Please see the following Help items for more information regarding mesh creation in JMAG-Designer. 

JMAG-Designer Help > Functions of Analysis > Mesh > Mesh 

 

 

  OPERATION METHODS FAQ-898  

Q３．Can I use my subroutines from JMAG-Studio in JMAG-Designer? 

A３．Subroutines from magnetic field analysis and thermal analysis can be used 
directly, but subroutines from other modules need to be recompiled. 

The API of subroutines from magnetic field analysis and thermal analysis are in C, so they can be used in 

JMAG-Designer as they are. 

Iron loss, magnetization, and electric field subroutines need to be recompiled. 

 

Subroutine modules (DLLs) that can be used directly in JMAG-Designer: 

・ Magnetic field analysis 

・ Thermal analysis 

 

Subroutine modules that need to be recompiled: 

・ Iron loss analysis 

・ Magnetization analysis 

・ Electric field analysis 

 

The compilation environment is different from JMAG-Studio’s, so please be careful. 

JMAG-Designer’s compilation environment is as follows: 

 

 Microsoft Visual Studio 2010 

 Intel Visual Fortran Composer XE 2011 for Windows* (Intel Fortran Compiler 12.1) 
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  OPERATION METHODS FAQ-899  

Q４．Can I use my scripts from JMAG-Studio in JMAG-Designer? 

A４．They cannot be used. The script language is different, so you will need to create 
them again. 

The script languages for JMAG-Studio and JMAG-Designer are different. Because of this, scripts that had been used in 

JMAG-Studio unfortunately cannot be used in JMAG-Designer. We apologize for the trouble, but you will need to create 

your scripts again. 

However, it is not at all difficult to create scripts in JMAG-Designer. There is an automatic recording function, so the 

procedures you want to create can easily be converted into scripts. Also, scripts in JMAG-Studio use a unique language, 

so they have limited utility for numerical calculation, linking to Microsoft Excel, and other uses, but JMAG-Designer uses 

general-purpose script languages and so has a high degree of freedom in code syntax, allowing a wide range of 

processing. JMAG-Designer supports VBScript, Jscript, and Python. 

 

If the script you were using in JMAG-Studio was for parametric analysis, it is easy to carry out parametric analysis using 

JMAG-Designer’s case control function. The case control function can be used for not only conditions settings, but also for 

design variables such as geometry parameters and mesh parameters. Also, simple optimization processing using 

objective functions is possible. 

 

【Other resources】 

Please see the following materials for more information regarding differences in scripts between JMAG-Designer and 

JMAG-Studio. 

http://www.jmag-international.com/support/en/seminar/pdf/uc2011_30_eng.pdf 

Please see the following Help items for more information regarding case control functions and optimization functions in 

JMAG-Designer. 

JMAG-Designer Help > Analysis > Parametric Analysis 

JMAG-Designer Help > Analysis > Optimization 

 

 

  OPERATION METHODS FAQ-900  

Q５．How can I perform a Fourier transform on a history graph? 

A５．Use the Fourier Transform function in the Graph Manager. 

Table data such as time series data and section graphs obtained in analysis can be edited and managed as table sets in 

the Graph Manager. Fourier transform processing is also done via the Graph Manager. The exact procedure is as follows: 

 

For example, if Fourier transform is desired for a torque waveform: 
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1) Set the Torque condition and carry out a Magnetic Field / Transient Response analysis. 

2) When the analysis if finished, open the Graph Manager. Select [Graph Manager] under the [Tools] menu. 

3) Find the torque data set in the data set list. 

4) Click the [Transform] button in the Graph Manager dialog and choose [Fourier Transform]. 

5) Enter the [Output Type] and [Range], and then click [OK]. 

6) The Fourier transform data set is added to the list of graphs in the lower half of the Graph Manager. 

 

The Graph Manager can show not only analysis results data, but also any data sets such as CSV files and point 

sequence files (*.pa). 

 

【Other resources】 

Please see the following Help items for more information regarding the Graph Manager function in JMAG-Designer. 

JMAG-Designer Help > Result Display > Graph Manager 

 

  OPERATION METHODS FAQ-901  

Q６．Can I confirm analysis results at the single-element level? 

A６．Yes, you can confirm results per element. 

The Table function can be used to confirm results per element. The exact procedure is as follows: 

 

1) Set the selection mode to [Select Element]. Choose [Select Element] from the tool buttons. 

2) In the model display window, select the element for which you want to confirm results. You can select multiple 

elements by holding the [Shift] or [Ctrl] key on your keyboard. 

3) Display the right-click menu on the model display window, and select [Show Table].  

4) Specify the physical quantity and step number you want to confirm and click [OK]. 

 

JMAG-Designer has a wide variety of collection and tabulation functions for distribution amounts at the element level, 

and these are listed below. Tabulation work that was previously done by outputting values and working by hand can now 

be accomplished automatically. 

 

・ Create FFT Calculation 

Runs a fast Fourier transform on distribution amounts output by transient response analysis. 

Distributions can be confirmed per frequency component. 

・ Difference Calculation 

Calculates the difference or ratio of the results from two cases. 

For example, variations in the magnetic flux density distribution when conditions or materials are changed can be 

confirmed in a contour plot. 

・ Add Part Calculation 
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Calculates the total sum of the physical amount for the selected part (faces, edges) or the maximum value and 

displays a table. 

For example, the amount of current flowing through any cross-section can be obtained, or a history graph of 

maximum temperatures in a model can be created. 

 

【Other resources】 

Please see the following Help items for more information regarding table functions in JMAG-Designer. 

JMAG-Designer Help > Result Display > Tables > Displaying a Table 

Please see the following Help items for more information regarding calculation processes for physical quantities in 

JMAG-Designer. 

JMAG-Designer Help > Result Display > Calculation Process 

JMAG-Designer Help > Result Display > Tables > Adding Calculation for Parts, Faces, and Edges 

 

 

Technical FAQ on the Web 

The Technical-FAQs section of the JMAG webpage has been redesigned as of March 29. More topics have been 

added, and categories have been reconsidered to make it easier for you to find answers to your questions. Please take a 

look at the new, more powerful Technical-FAQs when you have a chance. 

URL: http://www.jmag-international.com/support/en/faq/ (user verification required) 

 

The technical FAQ is a collection of actual questions from our clients, so you might discover some new ways to use 

JMAG if you go through them. We also update the FAQ on our homepage regularly, and we hope that you can use them 

along with the JMAG Newsletter to help streamline your analysis operations. Please don't hesitate to use JMAG technical 

support if you have any questions when using JMAG. We hope you will fully master JMAG-Designer!   

            (Takashi Kondo） 
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Fully Mastering JMAG 

Issue 8 Understanding Conditions from A to Z 
 

Continuing from last issue, I would like to introduce convenient functions for some of the conditions in JMAG's 

magnetic field analysis. I hope you will find this useful for finding new conditions and to remind yourself of various 

functions. In this issue, I will present functions to make complicated analyses easy, such as conditions for coupled 

analysis within JMAG and linked analysis with other software, as well as solver parameters such as nonlinear and 

ICCG. I hope you will aim to fully master JMAG and make your work more efficient. 

 

 

Overview 

In this issue’s A to Z, I will present conditions 

used for linking JMAG magnetic field analysis with 

other kinds of analysis, and also with other software. 

I will also present conditions for easily managing 

complex modeling and analysis properties that 

govern general analysis settings. 

 

Linking 
JMAG-Designer has functions for thermal and 

structural analysis in addition to magnetic field 

analysis. It is particularly robust for linking with 

structural and thermal analysis software such as 

Abaqus and Virtual.Lab, and also with the HILS 

ECU evaluation system (Fig. 1). Here, I will 

introduce necessary functions for linked analysis 

with these, and also for coupled analysis within 

JMAG. 

 

Fig. 1 JMAG and surrounding software 

(HILS is a company name. Only software titles relevant are 

included here) 

Partial Model 
This condition is for accurately transferring the 

temperature distribution to a magnetic field analysis 

when making a partial thermal analysis model with 

periodicity or symmetry for coupled thermal and 

magnetic field analysis. 

It is possible to use a partial model when a model 

has periodicity or symmetry by simplifying the 

thermal structure. However, a full model may be 

necessary for magnetic field analysis depending on 

the core geometry or the relationship between the 

number of poles and number of slots in a rotating 

machine (Fig. 2). In such cases, this condition can 

be used to accurately transfer the temperatures 

generated in the thermal analysis to the magnetic 

field analysis. 

Fig. 2 Transferring temperatures from thermal analysis to 

magnetic field analysis 
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External Circuit Link 
This condition is set when linking JMAG and SILS 

software. 

Electric machine drive is becoming increasingly 

complex, and in order to predict machine 

performance, the link between electromagnetic field 

analysis and drive circuits cannot be broken. In 

such cases, it is effective to analyze the drive circuit 

with MATLAB/Simulink or PSIM and do 

electromagnetic field analysis in JMAG. 

For the External Circuit Link condition, choose 

the terminals you want to display in the external 

circuit simulator (Simulink, PSIM, etc.) (Fig. 3). As 

examples, you might think of the torque used for 

control in an external circuit and the electric 

potential, etc. for drive in JMAG. Linked analysis is 

achieved by connecting the connection terminals 

that appear from JMAG’s block with another block 

in the external circuit simulator. 

 I would also like you to know about the further 

evolution of this condition in the JMAG-RT system 

for faster linked analysis. This is recommended 

when linking with SILS, MILS, and HILS systems. 

Settings are done via the JMAG-RT Library 

Manager. 

Here is one example use. Line-start is one 

startup method for induction motors. It is often seen 

as a problem for the startup current to grow too 

large, but it is not possible to estimate it with 

electromagnetic field analysis alone due to the 

complexity of the drive circuit. With this condition, it 

becomes possible to link MATLAB/Simulink and 

JMAG (Fig. 4.) to evaluate the current (Fig. 5). 

 

 

      Fig. 3 External Circuit Link condition panel 

 

 

         Fig. 4 MATLAB/Simulink setting diagram 

 

 

        Fig. 5 Induction motor startup current evaluation 

 

Frozen Permeability 
This makes it possible to use past JMAG 

electromagnetic field analysis results to identify 

material properties in subsequent electromagnetic 

field analyses. For example, it is used in cases like 

the following: 

- To separate a rotating machine’s torque into 

magnet torque and reluctance torque. 

- To precisely calculate the dynamic 

inductance with DC superposed in a reactor, 

etc. 
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Here I will discuss separating a rotating machine’s 

torque. First, a normal electromagnetic field 

analysis is run on the rotating machine (hereafter 

called Analysis A). Next, an analysis is run of the 

magnetomotive force for the magnets only 

(hereafter called Analysis B). Frozen Permeability is 

set in Analysis B, with the results file from Analysis 

A specified. This way, material operating points 

from Analysis A are used in Analysis B. 

If the results obtained from Analysis B are defined 

as the magnet torque, the reluctance torque is 

obtained by subtracting Analysis B’s torque from 

Analysis A’s (Fig. 6). An exact torque separation is 

difficult, but the torque can be separated here by 

assuming that the operating point does not change. 

 

Fig. 6 Torque separation results for a rotating machine 

 

Stress Distribution 
This condition is used to display the deterioration 

of magnetic properties in magnetic steel sheet 

caused by stress. 

Magnetic steel sheet’s magnetic properties are 

known to deteriorate due to stress. This leads to 

concerns about increased loss. With JMAG’s Stress 

Distribution condition, it is possible to set the stress 

for each part and replicate the materials’ 

deterioration. For coupled magnetic field - structural 

analysis, the stress distribution obtained in the 

structural analysis can also be represented in the 

magnetic field analysis. 

This can also be used while linking with other 

software. For example, in the example below, 

stress distribution results obtained in Abaqus are 

represented in JMAG for an iron loss calculation 

(Fig. 7). 

 

Fig. 7 Iron loss calculation accounting for stress (linked to 

Abaqus) 

 

Displacement 
Magnetic circuits also change when a geometry 

is changed. The Displacement condition is for 

carrying out linked analyses in JMAG and Abaqus 

that take geometry changes into account. 

For example, when a billet is subjected to 

compression, it is squashed and its geometry 

changes as seen below. Its magnetic properties 

may also deteriorate due to a rise in temperature. 

Magnetic field analysis considering these factors 

can be done by using this condition (Fig. 8). 

The Displacement function can also be used for 

coupled magnetic field – structural analysis within 

JMAG. 

Fig. 8 JMAG-Abaqus linked analysis using the Displacement 

condition 
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Reusing Demagnetization 
Magnets that have already undergone 

irreversible demagnetization may be used in 

subsequent analyses. When using magnets that 

have already been used without being 

remagnetized, such as when reusing the rotor of a 

rotating machine, etc., there may be concerns 

about the effects of demagnetization caused during 

earlier operation. In JMAG, a 2-stage analysis can 

be done for a performance estimate in these cases. 

In the example below, the first stage is an 

analysis of the rotating machine during operation. In 

the second stage analysis, the results from the first 

stage are set in the Reusing Demagnetization 

condition to express the demagnetized state. 

The reduction in torque during reuse, due to the 

effects of irreversible demagnetization caused by 

the heat generated in the first stage, is estimated 

using analysis (Fig. 9). 

 

   Fig. 9 Torque reduction from irreversible 

demagnetization 

 

 

Modeling 
There are probably many who think that 

complicated settings are needed to do 

high-precision analysis of complex phenomena. But 

with JMAG, complex analysis can be easily 

achieved through some tricks in the modeling 

process. I will now introduce some conditions that 

will allow you to use these tricks. 

External Field 
This condition is used for analysis of objects 

inside a uniform magnetic field. Normally, in order to 

produce a magnetic field in space, it is necessary to 

produce magnetomotive force by creating a coil as 

a finite element model and setting a Current 

condition, or by linking to a circuit. By using this 

condition, a uniform magnetic field can be 

generated without modeling a coil, therefore 

reducing modeling time. 

For example, this is an effective function for 

evaluating the performance of a shield placed in a 

uniform magnetic field as shown in Fig. 10. It can be 

seen that in this model, the magnetic flux density in 

the area around the shield is high in the red boxes 

and low near the blue boxes. Shields are usually 

made of thin parts, and because JMAG also has 

functions for automatically creating a thin shell 

mesh, using these together is convenient. 

 

      Fig. 10 Magnetic flux density distribution around a 

shield 

 

Gap 
This condition is for setting very thin magnetic air 

gaps without generating a mesh. 

For example, when a core is constructed with 

multiple core divisions, thin air gaps are created 

between them. Because air gaps cause strong 

magnetic resistance, it is preferable to generate a 

mesh for them in order to be sure of accurate 

analysis. However, the number of mesh elements 
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will become much greater if the mesh is created for 

the thin air gaps, and more calculation time will be 

required. The ICCG convergence may also 

deteriorate due to the mesh becoming too thin. 

With this function, this magnetic resistance can 

be expressed without the need to generate a mesh 

in the thin air gaps. 

In the graph below, this condition is used to 

evaluate coil magnetic flux while varying the gap 

width of a reactor’s center gap from 0.1 mm to 2 

mm without generating a mesh (Fig. 11). Magnetic 

flux evaluation is made easy by using Case Control 

in JMAG-Designer. 

 

        Fig. 11 Relationship between gap width and 

magnetic flux 

 

Insulation 
Similar to the Gap condition, this condition is for 

expressing electric insulation without modeling the 

air gaps built into cores or magnets. 

For example, magnets are sometimes divided to 

reduce eddy currents, but it can require a lot of work 

to create another model every time the number of 

divisions is changed if mesh is generated in the 

gaps. 

The electric insulation can be modeled simply by 

setting this condition to the division faces or by 

checking the Insulation check box for the part. 

Precise evaluation of eddy currents is done easily 

without the need to change the mesh (Fig. 12). 

 

    Fig. 12 Evaluation of eddy current reduction due to 

magnet division 

 

Section 
This function makes it possible to automatically 

extract a 2D cross-section from a 3D model for 

analysis. 

2D analysis is considered to provide adequate 

precision when the shaft length is long compared to 

the radius. For example, looking at a rotating 

machine’s torque history, there is only a difference 

of a few percent between 3D and 2D analysis (Fig. 

13). Analysis could be done by first obtaining a 

rough estimation in 2D analysis and then running 

3D analysis when seeking more detailed precision. 

If this were the case, it would be a lot of work to 

make a separate model just for 2D analysis, but a 

2D model can be automatically output from a 3D 

solid model using JMAG’s Section condition (Fig. 

14). The analysis could be done immediately 

without the need to set materials, conditions, etc. 

again. 
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Fig. 13 Torque history (comparison of 2D and 3D) 

 

 

Fig. 14 Cross-section analysis settings 

 

Output 
In addition to physical quantities such as torque 

and magnetic flux density, for which results are 

commonly evaluated, JMAG’s magnetic field 

analysis can also output physical quantities with 

more specialized uses. Two of these physical 

quantities are presented below. 

 

Magnetostriction 
This is used for evaluating magnetic strain. 

Vibration caused by strain is particularly hard to 

ignore in large transformers, so it is helpful to be 

able to estimate it using analysis. 

JMAG’s Magnetostriction condition checks the 

magnetic field distribution obtained in magnetic field 

analysis against the magnetic flux density - strain 

properties, and converts it to magnetostriction. 

Vibration analysis is possible using this as the 

source of vibration (Fig. 15). 

 

Fig. 15 Transformer using magnetostriction properties and 

magnetic flux density 

 

Partial Inductance 
This condition is used to output self- and mutual 

inductance generated in selected parts as a matrix 

model. 

For example, inductance in the wiring seen in 

busbars inside inverters, etc. varies widely 

depending on the geometry and spatial 

arrangements. Too large of an inductance can lead 

to surges during switching, so this must be 

improved. 

However, actually measuring the inductance can 

only yield a value for the entire measurement target. 

This means that you cannot tell where in the wiring 

most of the inductance is. But by using this 

condition, you can see at a glance which areas to 

improve because the self- and mutual inductance is 

calculated in a matrix model for parts that have 

already been separated (Fig. 16). 

In the example below, the surge voltage 

evaluated by the circuit simulator is reduced more 

than 10% by changing the geometry from the initial 

proposal based on examination of the inductance 

matrix of the busbar parts (Fig. 17). 
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     Fig. 16 Geometry improvement based on study of the 

inductance matrix 

 

 

             Fig. 17 Surge voltage reduction 

 

Study Properties 
Parameter tuning for time step settings, 

conversion, and iterative methods is done under 

Study Properties in JMAG-Designer. 

 

Step 
This contains settings for time steps. The 

number of steps, division method, end time, etc. 

are all set here. 

 

Conversion 
Periodic boundaries are often used in magnetic 

field analysis, and this converts those results to a 

full model for output. This is recommended 

because it allows results to be compared directly 

with actual measurements. 

 

Circuit 
This converts the parameters set to a circuit. It is 

effective when a partial model is being used. 

With conversion, values such as vibration, 

resistance, and inductance for the power source 

specified in an analysis can be set to a full model. 

 

Solver 
This is where to handle: settings for Parallel 

Computing; Steady-State Approximate Transient 

Analysis that is run to make steadying faster in 

terms of time; and settings for Time Periodic 

Explicit Error Correction functions. 

Under Parallel Computing, Shared Memory 

Multiprocessing (SMP) or Distributed Memory 

Multiprocessing (DMP) can be selected. Also, a 

GPU can be employed to increase speed. 

Steady-State Approximate Transient Analysis is 

used when no delay is needed for starting up 

current, etc. generated by inductance effects in 

applications where there are no magnets 

(stationary devices, induction machines, etc.). 

Time Periodic Explicit Error Correction is used 

for the same kinds of purposes, but can be used in 

PM motors, which have magnets (Fig. 18). It is 

also effective for rapid steadying of superimposed 

conditions such as switching transformers. 

 

         Fig. 18 SPM motor torque history 
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ICCG and Nonlinear 
Iterative methods are used for solution-finding by 

JMAG solvers. Robust high-speed ICCG is used 

by the linear solver, and the Newton-Raphson 

method is used as a nonlinear iterative method. 

Convergence parameters for each of these are set 

here. 

When convergence is slow in ICCG, setting the 

Acceleration Coefficient slightly higher may 

improve the convergence. Likewise, changing the 

default threshold value of nonlinear iterations from 

1e-3 to around 1e-4 can help to increase precision 

when using nonlinear materials. There may not be 

many people who are even aware of these 

parameters, but I think it is a good idea to adjust 

parameters a little and see how sensitive 

calculation time and precision is to them, 

especially for those who are unsure whether their 

own analysis models are providing sufficiently fast 

and precise results. 

 

In Closing 
Over the past two issues, we have presented a 

number of conditions used in magnetic field 

analysis in JMAG. I hope you have found some that 

you will be able to use in your own analyses. I also 

hope that you have gained more detailed 

knowledge of the conditions you already use on a 

regular basis. 

JMAG’s functions will continue to grow in the 

future. New conditions are often presented at our 

seminars and other events. It is our hope that you 

will be able to fully master all of these conditions.                    

  (Kazuki Semba)  
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Event Information  

Information on the JMAG Users Conference in Germany  
 

Building on last year’s success, countries around the world will play host to a JMAG Users Conference 2013. In this 

issue, we are pleased to announce one in Germany. 

JMAG Users Conferences are programs that emphasize engineers communicating with each other. They are an 

excellent chance to collect information on ways that electromagnetic field analysis is being used and other topics, so 

please attend if you are able. 

 

JMAG Users Conference in Germany and JMAG Technical Day 
Conference Outline 
Host:  Powersys Solutions 

Dates:  Wednesday, April 10 - Thursday, April 11, 2013 

Venue:  Steigenberger Airport Hotel Frankfurt (Frankfurt, Germany) 

URL: http://www.powersys-solutions.com/JMAG_UC/ 

 

Program (Day 2) 

09:45 
Investigation of Proximity Losses in a Permanent Magnet Machine for electric vehicles 

David Bauer, Robert Bosch GmbH, Germany. 

11:00 
Development of electric motors in automotive applications using JMAG Software 

Mohamed Hadjali, Nidec Motors & Actuators, Germany. 

11:40 
Enhanced Simulation Quality for Electric Drives in Hardware-in-the-Loop Applications 

Bjoern Bobe & Matthias Deter, dSPACE GmbH, Germany. 

14:00 

Axial flux machine simulation with JMAG 

Dr.-Ing. Bogdan Funieru for Institute for Electrical Energy Conversion, Technische Universität Darmstadt, 

Germany. 

14:40 

Optimizing the Acoustic Performance of a Switched Reluctance Motor using a combined multi-physics 

& FEA simulation approach 

Ben Meek, Koen De Lange, Koen Vansant, Fabio Santos, Herman Van Der Auwerar, 

Jan Anthonis, LMS International N.V, Belgium. 

16:00 
Calculation of electromagnetic forces in claw-pole alternators for acoustic simulation 

Antoine Tan-Kim, VALEO EEM, France. 

16:40 
Title to be defined 

SYNOPSYS 

 

 

JMAG Users Conference 2013 will start in Germany. 

At the two-day Users Conference in Germany, the first day will be a Technical Day, and the second will see 
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presentations of users’ applications. 

At the Technical Day, JMAG Designer Ver.12.1, due for release later this spring, will be debuted early. Also, like at the 

Users Conference in Japan, time will be set aside for technical discussion, so users will be able to speak freely about the 

direction of analysis technology and desired functions for JMAG. 

For presentations of users’ applications on the second day, we are lucky to have presentations by Robert Bosch, Nidec 

Motors & Actuators, Valeo EEM, Technische Universität Darmstadt, and other technical partners. 

 

Sponsors 

   

 

   

 

   
 

 

Scenes from the 2012 Conference 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Editor: Tomomi Igarashi  
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Event Information  

Exhibit Introduction for April-June 2013 
 

JMAG is actively exhibiting at events both in Japan and overseas. Please see how JMAG is performing at the venues.

Here we introduce events in April and June 2013 at which we will exhibit. 

 

Virtual Testing and Validation of Controller Software 
Conference Outline 
Host: dSPACE Inc. 

Dates: Tuesday, April 9 - Thursday, April 11, 2013 

Locations: April 9：Hotel Arista (Illinois, USA) 

 April 11: DoubleTree (Michigan, USA) 

URL: http://www.dspace.com/en/inc/home/company/events/dspace_events/seminar_vet_il.cfm 

 

Our North American distributor Powersys Solutions will propose the ECU validation environment for high-precision 

motor modeling using JMAG-RT and dSPACE ASM. We will deepen our partnerships so that JMAG-RT can be used along 

with MotorHIL in North America. 

 

CAE Summit 
Conference Outline 
Host: Otsuka Corporation 

Date: Wednesday, April 14, 2013 

Venue: Otsuka Corporation Head Office (Tokyo, Japan) 

URL: http://event.otsuka-shokai.co.jp/13/0424cae/  (only in Japanese) 

 

JMAG is an electromagnetic field analysis software package for high-speed and high-precision analysis of the complex 

physical phenomena inside electrical devices. For use by designers, it allows seamless linking functionality with 

SolidWorks and other CAD software. Because it makes possible geometry revisions in CAD while preserving analysis 

conditions and material settings, design evaluation can be done in a relatively quick cycle. 

Further, JMAG includes tools that can do multifaceted evaluation linked to vibration, thermal, and other results analyzed 

in other software with pre-loaded workflows, such as JMAG-VTB and Abaqus, so that even engineers who are not 

well-versed in analysis can carry out advanced analyses. 

At this conference, JMAG’s functionality and example uses will be introduced, focusing on “JMAG99,” Otsuka 

Corporation’s package. 
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2013SIMULIA Community Conference 
Conference Outline 
Host: Dassault Systemes SIMULIA 

Dates: Wednesday, May 22 – Friday, May 24 2013 

Venue: Hilton Vienna Stadtpark (Vienna, Austria) 

URL: http://www.3ds.com/company/events/scc-2013/overview/ 

 

We will have an exhibit at the SIMULIA Conference, as we did last year. 

At our booth, we will present not only electrical design using electric field analysis, but also example applications for 

users investigating structural design and thermal design at the same time. By combining magnetic field analysis with 

structural and thermal analysis, product evaluations that used only magnetic field analysis in the past can now be carried 

out from a wider variety of points of view. Please stop by our booth and check for example applications. 

 

Coil Winding Berlin  
- The World’s largest International Coil Winding,  
 Insulation & Electrical Manufacturing Exhibition - 

Conference Outline 
Host: CWIEME 

Dates: Tuesday, June 4 – Thursday, June 6, 2013 

Venue: Messe Berlin (Berlin, Germany) 

URL: http://www.coilwindingexpo.com/BERLIN/ 

 

Engineers gather from around the world, particularly Europe, with booths related to large transformers and wind power 

generation at Coil Winding, the world’s largest exhibition for coils and windings. 

This year’s JMAG booth will be expanded over last year’s, and will feature demonstrations centering on example 

analyses for motors and transformers. The presentations in our booth are received well every year, so be sure to drop by. 

 

 

As you can see, we will be quite active in Europe from April to June, especially with the Users Conference in Germany. 

You will have a chance to be the first to see JMAG-Designer Ver.12 that is to be released in early summer in 2013 at 

Users Conference in each country. 

In addition, we plan to give exhibits and hold seminars not only in Europe but also countries around the world. By all 

means, please visit our web site and check the information. We look forward to seeing you at the conference. 

 

（Tomomi Igarashi）  
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Event Information  

Event Report 
 

Attendees report on events held from January to March, 2013. We hope you will attend an event soon. 

 

JMAG Techno Seminar 
Conference Outline 
Host: JSOL Corporation, JSIM Ltd. 

Date: Tuesday, February 12, 2013 

Venue: King Mongkut Institute of Technology Ladkrabang (Bangkok, Thailand) 

 

In recent years, construction of distribution networks and technical training for 

operations and sales in China, South Korea, and Southeast Asian countries has 

progressed in order to keep up with the movement of business by customers moving 

their product development and design overseas. Thailand has particularly seen 

advances in Japanese manufacturing over a long period of time, and its infrastructure 

has formed faster than other developing countries as most current customers have expanded there. At first, the focus was 

on physical manufacturing, but design, research, and development have slowly been taking some of the share of local 

manufacturing. 

With this background, we held a JMAG Techno Seminar for our Thai customers. This was the second seminar 

introducing JMAG in Thailand. 

For advanced product development using simulation, not only the introduction of software, but also knowledge of 

materials and electromagnetic field phenomena as well as a lot of peripheral knowledge is necessary. With the 

cooperation of JSIM Ltd., who have experience with most CAE software, JSOL was able to provide technical support for 

customers through local engineers. 

In the morning, we explained basic ways of thinking about electromagnetic fields in addition to an introduction to JMAG, 

and in the afternoon attendees were able to practice motor and transformer analysis using actual terminals. It was a quite 

lengthy and hard seminar, but the attendees were very enthusiastic and the question-and-answer continued even after the 

official end of the seminar. JSOL will endeavor to create a structure to provide the apex of CAE solutions and carry one 

part of our customers’ global strategy. 

(Takahiko Miyachi)  
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Multiphysics Simulations Using Abaqus and JMAG for Electromagnetic Equipment 
Design 
Conference Outline 
Host: Powersys Solutions、Dassault Systemes SIMULIA 

Date: Wednesday, March 6, 2013 

Venue: Dearborn (Michigan, USA) 

URL: http://www.powersys-solutions.com/Seminar_Multiphysics_Simulations.php 

 

A seminar on linked analysis with JMAG and SIMULIA Corporation’s Abaqus structural and thermal analysis software 

was held at SIMULIA’s Dearborn offices. There were about 20 structural design engineers and other attendees at the 

seminar, mainly related to Detroit’s automobile industry. 

At the seminar, we gave a presentation including examples of phenomena that can be analyzed by taking advantage of 

JMAG’s electromagnetic field analysis functions along with Abaqus’ thermal and structural analysis functions, such as 

high-frequency induction heating of structural parts, effects of heat and stress on motor characteristics, effects of heat 

stress when current flows in a busbar, etc. Even after the seminar, we received many questions from attendees about 

individual issues, which showed us the amount of interest in this technical field. 

(Tetsuo Ogawa） 

 

Modern Simulation for Electric Motors Seminar 
Conference Outline 
Host: LMS International, Powersys Solutions 

Date: Tuesday, March 12, 2013 

Venue: LMS North America Office (Michigan, USA) 

The LMS Seminar was a 1 day event held at LMS’s Troy, Michigan offices. There were approximately 26 attendees from 

a variety of companies. The seminar discussed how to model electromagnetic forces and incorporate those results into a 

noise and vibration simulation. The first half of the day focused on modeling electric motors in JMAG, specifically an IPM 

machine and a SR machine. The second half of the day discussed how to transfer the forces to LMS’s Virtual.Lab for 

further analysis, including correlating the results with actual measurements. There attendees asked many good questions 

about this process and had very positive feedback. They liked the fact that linking JMAG and Virtual.Lab is becoming more 

seamless and they were interested in identifying applications that could benefit from this capability. 

（Dave Farnia）  
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GPU Technology Conference (GTC) 2013 
Conference Outline 
Host: NVIDIA Corporation 

Date: Wednesday, March 20, 2013 

Venue: San Jose McEnery Convention Center (California, USA) 

URL: http://www.gputechconf.com/page/home.html 

 

The NVIDIA GPU Technology conference was held in San Jose, California and had attendees from every facet of 

industry. The purpose of the event was to present the advances in GPU (Graphic Processing Unit) technology. Whereas 

GPUs were only used to display graphics, they are now competing with CPUs in processing functionality. NVIDIA is a 

leader in moving this technology forward and the progress they have made is startling. The atmosphere was boisterous 

due to all the breakthroughs that NVIDIA announced. There were, of course, demonstrations of visualization improvement 

including 3D displays and more elaborate rendering. But there were also examples of GPUs being used to in server type 

applications or reducing computation time. JSOL’s paper discussed how customers are using GPUs to realize substantial 

analysis speed improvements. And from the conference, it seems that the rapid performance improvements in GPUs will 

not slow down any time soon. 

（Dave Farnia）  

 

JMAG Users Conference 2012 
Presentation-day handout materials now available “For Users Only” 

Presented papers and workshop materials from the JMAG Users Conference 2012 are now available on the our 

users-only website. Please feel free to download them. 

http://www.jmag-international.com/support/en/documentation/seminar_uw2012.html 

*A user ID and password are needed to access the site. If you do not know yours, please contact the person responsible 

for the license at your company. 

 

 

This issue’s Event Report focuses on exhibitions held in the United States. JMAG will continue to not only provide 

technical support, but also provide better products that can carry a part of our customers’ global strategy in the future. 

Editor: Tomomi Igarashi  
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